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Print Screen Deluxe is the original and really the ultimate screen capture utility. It provides a 
fast, easy, and intuitive way to capture, print, and save your screen. One keystroke does it all! 
With one keystroke you can capture and print the entire screen, the current window, a selected 
region, and more. Changes in version 5 include a beautifully enhanced print function that lets 
you do everything from one screen. Select a printer, add the date and time, expand or shrink the 
image, and more. Print Screen Deluxe 5.2 also lets you highlight portions of the screen, add 
comments, and insert arrows. The intuitive interface has been updated to make it even easier to 
use. Print Screen Deluxe also features options like auto scroll, time-delay capture, sending a 
capture by email, and a wide range of image enhancement functions. These include things like 
gray scale, gamma corrections, mirror, and many more. So easy-to-use, Print Screen Deluxe is 
perfect for both new and experienced users! 
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Product Support
American Systems provides user support to registered versions via mail, and/or telephone.

American Systems will answer questions and resolve serious bugs for the first three months after 
registration.    For problems involving a specific hardware or software environment or feature, we may 
choose not to modify the program.    In that case, if a problem is reported within three months after 
purchase, then we shall offer to refund the user's purchase price.

If a bug prevents you from evaluating Print Screen Deluxe during the first 30 days (prior to purchase), 
American Systems    will attempt to assist but is not under obligation to resolve issues beyond our control.

          Phone:
                                          (817)485-6547

          Fax:
                                          (817)485-2193

          Internet:
                                          support@americansys.com

          Address:    
                                          American Systems
                                          P.O. Box 93747
                                          Southlake, TX, 76092
                                          Care of Technical Support

Please share the evaluation version of Print Screen Deluxe with others for the purpose of evaluation as 
long as it is unaltered and distributed in its entirety.

How to use Print Screen Deluxe
Ordering Print Screen Deluxe



How do I Capture a Screen?
With Print Screen Deluxe you can capture any of the following

· The entire screen
· The current active window
· A selected rectangle region of the screen
· A selected round rectangle region of the screen
· A selected ellipse (circle) region of the screen
· A selected freehand outline region of the screen
· A selected triangle region of the screen
· A selected polygon outline region of the screen
· Any window
· Any menu
· Clipboard Images
· Clipboard Text and DOS Screens
· DirectX Screens
· Entire documents such as web pages (using the Auto Scroll option)

You can select capture options in 2 places.    Either in the options menu (see below)



  

Or in the File..Preferencs window (see below)



 

If you would like to capture the entire screen then do the following.

1. Make sure that you have the 'Options'..'Capture Options'..'Entire Screen' option 
checked.    

2. Capture the entire screen by hitting the screen capture hot key (default is 
<PrintScreen>).    

3. A copy of the entire screen will appear in the Print Screen Deluxe window.    You can then 
print, save, email or enhance it using the 'Special Effects' menu provided by Print Screen Deluxe.

If you would like to capture the current active window then do the following.

1. Make sure that you have the 'Options'..'Capture Options'..'Active Window' option checked.    

2. Capture the entire window by hitting the screen capture hot key (default is <PrintScreen>). 

3. A copy of the active window will appear in the Print Screen Deluxe window.    You can then 



print, save, email or enhance it using the 'Special Effects' menu provided by Print Screen Deluxe.

If you would like to capture a rectangle, ellipse, triangle, polygon, or round rectangle region 
of the screen then do the following.

1. Make sure that you have the 'Options'..'Capture Options'..'Rectangle' (or Ellipse, or Round 
Rectangle, or Triangle, or Polygon) option checked 

2. Start the screen captre by hitting the screen capture hot key (default is <PrintScreen>).

3. Your mouse cursor will change to crosshairs.    Move your mouse to the top left point of the are
you want to capture and hold your primary mouse button down.    

4. While holding the primary mouse button down, drag the mouse to the lower right point of the 
screen that you want to capture.    Notice that a rectangle, ellipse or round rectangle is being 
displayed that highlights the area of the screen to be captured.    

5. When you are happy with the area to capture, release the primary mouse button.    A copy of 
what you captured will appear in the Print Screen Deluxe window.    You can then print, save, 
email or enhance it using 'Special Effects' provided by Print Screen Deluxe

If you would like to capture a freehand cutout region of the screen then do the following.

1. Make sure that you have the 'Options'..'Capture Options'..'Freehand' option checked 

2. Start the screen captre by hitting the screen capture hot key (default is <PrintScreen>).

3. Your mouse cursor will change to crosshairs.    Move your mouse to beginning of the cutout 
area and hold your primary mouse button down.    Move the mouse around the object you are 
wanting to cut out then release the mouse button.

4. Notice that the cutout    is being displayed that highlights the area of the screen to be captured. 

5. A copy of what you captured will appear in the Print Screen Deluxe window.    You can then 
print, save, email or enhance it using 'Special Effects' provided by Print Screen Deluxe

If you would like to capture any window then do the following.

1. Make sure that you have the 'Options'..'Capture Options'..'Window' option checked 

2. Capture the window by hitting the screen capture hot key (default is <PrintScreen>).

3. Your mouse cursor will change to hand that points.    Move your mouse to the window that you



want to capture and click on it. (Note that a box highlights the currently selected window that 
will be captured when you release the mouse button).

4. A copy of the window you clicked on will appear in the Print Screen Deluxe window.    You 
can then print, save, email or enhance it using    'Special Effects' provided by Print Screen Deluxe

Note: You can capture entire documents such as web pages if you turn on the Auto Scroll 
option.    This will scroll the entire page and capture everything on that page.

If you would like to capture clipboard images then do the following.

1. Make sure that you have the 'Options'..'Capture Options'..'Clipboard Images' option checked 

2. Now anytime the contents of the clipboard changes, Print Screen Deluxe will make a copy of 
it and display it.    

3. You can then print, save, email or enhance it using 'Special Effects' provided by Print Screen 
Deluxe



Auto Print Screen Capture?
1. Make sure that you have the 'Options'..'Auto Print' option checked.    If it is not, then click on 
it.    If you look at it again it will be checked.

2. Now perform a screen capture by    hitting the hot key (default is <PrintScreen>)

3. When the capture is complete, watch your printer.    Your screen capture will print on your 
printer.



How do I change the hot key that initiates the
screen capture?

The easiest way is to click this yellow box inside the Print Screen Deluxe main window.

You will see this window pop up.

This window shows you a picture of your keyboard and which key is your hot key.    Click the <Change Hot
Key> button.

If you want to use <Print Screen> as your hot key, select it from the drop down list.    If not, select 
<Custom> in the drop down list and in the Custom Hot Key field, press the hot key on your keyboard you 
want.    You'll see the name of that key display in the Custom Hot Key field.    Then click <Ok>, then 
<Close>.

You can also change your hot key through the File..Preferences menu.

1. Click the 'File'..'Preferences' menu command.    The window below will appear.



 

2. Look at the bottom.    The default hot key is <PrintScreen>.    If you do not want to use the <Print 
Screen> key, click the drop down menu and click Custom.    Then go to the Custom Hot Key field and type
the hot key you want to use.



How do I run Print Screen Deluxe automatically
when Windows starts?

Make sure that the 'Options'..'Auto Start and Hide' option is checked.    If not, click on it and a check will 
appear.    The next time you start Windows, Print Screen Deluxe will start with the icon in the system tray 
(clock window on the task bar)



How do I open an existing image file to preview,
enhance, print or convert?
You can open a file in 1 of    2 ways.

1. Drag a awd, bmp, cal, cmp, cur, dic, eps, fxs, gif, img, ico, ica, jpg, mac, msp, pct, pcx, png, psd, ras, 
tga, tif wmf, or wpg    file onto the Print Screen Deluxe window 

or

2. Click the 'File'..'Open' menu command and use the window that appears to select the file you want.    
You can change the type of file you are looking for by clicking on the 'Files of Type' list.



Email an screen print?

Note: The Send Mail output option is only supported if you have a MAPI mail client installed (for example, 
Microsoft Exchange).

Once you open an image file or capture an image, click on the 'File'..'Send' menu command.    Your mail system 
create an email message containing your image and allow you to further edit your email.    At that point you can 
send, file, or do whatever you wish with your email.

Please note that once you click on the 'File'..'Send' command your email system takes over.    Print Screen Deluxe 
has no control over what happens in your email system.



How do I use Print Screen Deluxe to capture a
DOS Session?

Since Print Screen Deluxe is a Windows program it cannot capture DOS screens directly.    However, it 
can capture text that passes through the clipboard.    And since the contents of the DOS screen is sent to 
the clipboard when you press the <PrintScreen> key, Print Screen Deluxe can capture this text.    This is 
how Print Screen Deluxe captures DOS screens.

To capture a DOS screen do the following:

1. Click File..Preferences.    The window below will appear.

 

2. Make sure the 'Also capture all Clipboard Text including DOS Full Screens' is checked.

3. Enter your DOS session, get the DOS screen to look the way you want to capture and hit the 
<PrintScreen> key.

Note: If you choose this option, Print Screen Deluxe will capture the text in the Windows clipboard each 
time the clipboard receives new text from ANY application.    In other words, every time you Cut, or Copy 
text in another application, Print Screen Deluxe will capture that text.    Therefore if you have 'Auto Print' , 
the text will be printed.

Note: If your DOS session uses a proprietary video mode, you may not be able to use Print Screen 



Deluxe to capture DOS screens from that application. (When an MS-DOS application uses a proprietary 
video mode, Windows cannot capture the image to the clipboard, so Windows programs like Print Screen 
Deluxe cannot access the image.)



How do I automatically save my screen capture
to a file?

Make sure you have the 'Options'..'Auto Save' option checked. 

This automaticaly saves the screen print to a .BMP file when the screen capture hot key (default is 
<PrintScreen>) is pressed.    

The program can either 

a)Generate a file name like PS000010.BMP.    The first file name generated is PS000000.BMP.    The file 
name of each screen print that you want automatically saved after that will be incremented by one, for 
example, PS000001.BMP, then PS000002.BMP...

or 

b)prompt you for a filename.

You can set this option in the File..Preferences window.    See below.

 

This feature is very handy if you are documenting a program or system.    You can move through the 
program you are documenting, screen by screen, pressing the screen capture hot key (default is 
<PrintScreen>), saving them to files.





How do I crop off sections of the image?
Once you have captured or opened an image, you can crop or cut out sections of the image.    

1. Just draw a rectangle with your mouse around the area you want to cut or crop.    If you want a shape 
other than a rectangle, click the Edit..Select Region menu.    And select the shape you want to crop. 
(Rectangle, Round Rectangle, Ellipse, or Freehand). Then 
click the mouse button and hold it down to start drawing your outline.    Drag your mouse to the other end 
of the outline and release it.

3. Click the 'Edit'..'Crop' command if you want to cut out everything outside of the dashed line.    Or click 
'Edit'..'Cut' if you want to cut out everything inside the dashed line.



How do I correct my mistakes (i.e. use Undo)?
You may find that you cropped off some of the image that you really wanted, or that you applied some 
effects that you really did not want.    The 'Undo' feature is very handy to correct these mistakes.

Just click the 'Edit'..'Undo' command, and your image will return to its previous state.



Add Comments to my image?
1. Click the Edit..Add Comments menu.    The following message will appear.

 

2. Click <Ok> then your mouse will turn to a cross hair.    

3. Click the location on the screen where you want your comment to go.

4. The following window will appear.

 

Type the comment you want to place on your image then choose the color of the rectangle.    Here's what 
a comment looks like.



 



Enhance the image with imaging effects?
1. Click the.Special Effects menu.    You'll see the following list.

Choose the special effect you want to apply.    When you do the following window will appear.



 

2. To preview what the effect will look like, click <Preview>.    If you don't like it, click <Undo>

3. You can apply any number of effects you want.

4. When finished, click the <Apply> button.



Resize the Image?

1. Click the Edit..Resize menu.    The window below will appear.

 

2. Choose the size you want to resize the image too.    If you want to choose a custom size, click 
"I want to make my own size".    

The 'Aspect Ratio' ensures that the image size is proportional.



How do I schedule a screen capture?
You may wish to schedule a screen capture to run at a particular time.    We highly 
recommend EZ Scheduler from American Systems. EZ Scheduler is a FREE program 
from American Systems.    It is not trialware, it is totally free.    EZ Scheduler is specifially
designed to work with Print Screen Deluxe and other American Systems products.    It 
allows you to run screen captures and many other types of programs Hourly, Daily, 
Weekly, Monthly, Once, When Windows Starts, and more.    You can download this 
program from our web site at 

http://www.americansys.com

Notice on the Edit menu there is a "Schedule" command.    When you have installed EZ 
Scheduler, the    Schedule command prompts you to choose how you want to run your 
screen capture - Hourly, Daily, Weekly, Monthly, Once, When Windows Starts, etc. 
Select the time you want your capture to occur, and be sure to leave EZ Scheduler and 
Print Screen Deluxe running in your system tray. Your capture will take place at the 
specified time.

Below are some screen shots of EZ Scheduler.

 



 



How do I get the latest version of Print Screen
Deluxe?

Print Screen Deluxe has a really neat feature built in called "Live Update".

 

Live Update will connect to the American Systems web site using your Internet connection and retrieve 
the latest upgrade and install it for you.



 

If you have the latest version you will see a message similar to the following.

 

Otherwise you will see a screen with the features the new upgrade adds.    Just follow the instructions on 
the screen and install the new version.



Come see us on the web!
At our web site you can :

.    Download the fully functional EZ Scheduler for FREE.    No strings attached.

.    Download FREE evaluation versions of our software 

.    Learn more about ALL of our products 

.    Obtain technical support 

Come see us at :

http://www.americansys.com



Blowup the size of the printout

When you click File..Print you'll see the following window.

You can set options for this printout like the amount to shrink or expand the image in the printout, printing the 
current date and time, the user's name, the image file name, etc.    Then click <Print>

To change the default settings for the program so they will be set the way you like everytime you print something 
just do the following:

1. Click File..Preferences, then Program.    The following window will appear.



 

2. Move the slider bar to the desired image size.    The maximum printout size is 1000% of the 
original image size.



Control the location on the page where the image prints
When you click File..Print you'll see the following window.

Just click the list at the bottom of the window to change the location on the page the image prints at.    For 
example if you don't want it to print at the top left of the page, just click the list, and you'll see various 
choices.    Just select one and you'll see what it will print out like on the Preview window.

To change the default settings for the program so they will be set the way you like everytime you print 
something just do the following:

1. Click File..Preferences, then Program.    The following window will appear.



 

2. Click on the "Please print the image at" list to select where you want the image to print at.    Your 
choices are:

Top Left of the page
Top Center of the page
Top Right of the page
Middle Left of the page
Middle Center of the page
Middle Right of the page
Bottom Left of the page
Bottom Center of the page
Bottom Right of the page

Notice that the preview window changes everytime you select a different one.    This give you an idea of 
where on the page it will print.



Specify a time delay before the screen capture occurs
1.    Click File..Preferences..Program.    The window below will appear.

2. Notice the Time Delay options at the bottom of the window.

If you want to use a time delay, check the Use Time Delay box and specify the number of seconds to 
delay between the time you hit <PrintScreen> and the time the capture occurs.



Specify the folder that the Thumbnail Viewer and Auto Save
option uses

1.    Click File..Preferences..Program.    The window below will appear.

 

2. Notice the "What folder do you want to save your Auto Save files too?".    To change it, click 
the <Browse> button.



Q: "Why would I want to capture a "video" of my screen?" 

A: Capturing a video of the activity on your screen can be useful for several things. You can use 
the video capture feature for creating tutorials for others to look at. You can, for example, 
demonstrate how to open a file. Family or friends new to computers can play back your capture 
and see exactly what you did. Print Screen Deluxe will capture every mouse movement, every 
click, and more. A useful tool and a picture is worth a thousand words!

Q: "How do I capture a video of my screen?"

A: To capture a video of the activity on your screen, do the following:

1. Click on "File-Preferences" and make sure the button that says "Create a movie of events as 
they happen on my PC" is marked. Click "Apply" and "OK" to save your changes. 

2. Press the <PrintScreen> button, or the custom hot key you configured, to start the capture. 

3. While the capture is active you while hear a sound at about one second intervals. This is to 
remind you that the video capture mode is active.

4. When you want to end the video capture, simply press the <PrintScreen> button again (or the 
hot key you configured). 

5. You can now restore Print Screen Deluxe (if you don't have "Auto Popup" on) and play back 
your movie. You can use the play and stop buttons at the bottom of the screen to start and stop 
playback. 

6. Don't forget to name and save the file (if you don't have AutoSave turned on). The only valid 
file format for the video is .GIF



How do I use Print Screen Deluxe?
Print Screen Deluxe is the original and really the ultimate screen capture utility. It provides a 
fast, easy, and intuitive way to capture, print, and save your screen. One keystroke does it all! 
With one keystroke you can capture and print the entire screen, the current window, a selected 
region, and more. Changes in version 5 include a beautifully enhanced print function that lets 
you do everything from one screen. Select a printer, add the date and time, expand or shrink the 
image, and more. Print Screen Deluxe 5.2 also lets you highlight portions of the screen, add 
comments, and insert arrows. The intuitive interface has been updated to make it even easier to 
use. Print Screen Deluxe also features options like auto scroll, time-delay capture, sending a 
capture by email, and a wide range of image enhancement functions. These include things like 
gray scale, gamma corrections, mirror, and many more. So easy-to-use, Print Screen Deluxe is 
perfect for both new and experienced users! 
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How do I...
Capture a screen or capture a portion of the screen or window?
Automatically print my screen capture?
Automatically make my printout darker or lighter?
Change the hotkey to initiate the screen capture?
Activate Print Screen Deluxe automatically when Windows 95/98/Me or Window 
NT/2000/XP starts?
Make a video of things I do on my screen?
Open an existing image file to preview, enhance, print or convert?
Email an image?
Use Print Screen Deluxe to capture a DOS Session?
Automatically save my screen capture to a file?
Crop off sections of the image?
How do I correct my mistakes (i.e. use Undo)?
Add Comments to my image?
Enhance the image with imaging effects?
Resize the image?
Print the Current Date/Time, User's Name, and/or Filename on the printout?
Blowup the size of the printout?
Control the location on the page where the image prints?
Specify a time delay before the screen capture occurs?
Specify the folder that the Thumbnail Viewer and Auto Save option uses?
Schedule a screen capture?
How do I highlight a portion of my image in yellow - like a yellow highlighter marker?
How do I put arrows on my image to point out important things?
How do I get the latest version of Print Screen Deluxe?
Visit American Systems on the Web?

What do the menu commands do?



File Menu
 
Open
Open a previously saved screen print in a awd, bmp, cal, cmp, cur, dic, eps, fxs, gif, img, ico, 
ica, jpg, mac, msp, pct, pcx, png, psd, ras, tga, tif wmf, or wpg file.    Just type the name of the
file you want to open and press <OK>, or double click the desired file name to open the file.      To change 
the file type, click the 'Files of type' list and select the new type.

These files can be read in by many Windows programs.    If you are writing a document or presenation 
that you would like to import screen prints into, you will want to save them to a file.

The program will remember the directory you read your last file from and save the future screen prints 
there.

Note: You may also drag files into the Print Screen Deluxe window to open them.

Save
Saves changes to the current image

Save As...
Save the screen print to a file.    Just type the name of the file you want to save the screen print as and 
press <OK>, or double click the desired file name.    To change the file type, click the 'Files of type' list and
select the new type.

These files can be read in by many Windows programs.    If you are writing a document or presenation 
that you would like to import screen prints into, you will want to save them to a file.

The program will remember the directory you read your last file from and save the future screen prints 
there.

Acquire From your Digital Camera or Scanner

Print Screen Deluxe can open images that you have in your digital camera or scanner.    Just follow the on
screen instructions when you select this command.

Default Save Folder

Print Screen Deluxe will remember the last folder you saved an image too.    The next time you want to 
save an image it will start in this folder.    You can change this folder by using this command.

Preferences
Displays a window that allows you to change Print Screen Deluxe settings.

Print
Prints the displayed screen to the printer and allows you to change a few of the options.

Print Preview
Displays a window of what the printout will look like

Printer Setup
Displays the list of printers and printer drivers you have installed on your PC.    Select any printer and 
driver and press OK to print your screen prints to. 

Send



Attach the captured image to an email. Once the image is attached to the email,    the email will be 
displayed. You can then enter your regular email text and data and send your email. The Send Mail output
option is only supported if you have a MAPI mail client installed (for example, Microsoft Exchange).

Exit
Exits Print Screen Deluxe

Edit Menu
Undo
Undo the last change to the image.    Revert back to the previous image.    You can undo your changes 
back to the last time you saved or loaded the file, or pasted, cleared or captured an image.

Cut
Cut out the selected region of the image.

Copy
Copy the image or the    the selected region of the image to the clipboard.

Clear
Clear the contents of the Print Screen Deluxe window.

Paste
Paste the image on the clipboard into the Print Screen Deluxe window.
 
Crop
Once you have selected Edit..Select Region and outlined and area of the image, click Crop to remove 
everything outside the highlighted area.

Flip -> Horizontal
Flips the image horizontally

Flip -> Vertical
Flips the image Vertically

Flip -> Both
Flips the image horizontally and vertically

Resize 
See Resize the image

Select Region ->Rectangle
Highlight a rectangle area on the image.    Uses this for cropping and cutting.

Select Region ->Round Rectangle
Highlight a round rectangle area on the image.    Uses this for cropping and cutting.

Select Region ->Ellipse
Highlight a ellipse (circle) rectangle area on the image.    Uses this for cropping and cutting.

Select Region ->Freehand



Highlight a freehand area on the image.    Uses this for cropping and cutting.

Schedule
See Schedule a screen capture 

View Menu
Main Toolbar
Displays the main file and edit toolbar.

 

Capture Toolbar
Displays the capture toolbar that lets you change screen capture methods.

 

Zoom In
Lets you zoom in to the image up to 16 times it's normal size.

Zoom Out
Lets you zoom out of the image up to 16 times it's normal size.

Options Menu
Auto Print
Automatically prints the screen to the printer when the screen capture hot key (default is <PrintScreen>) 
is pressed.    If this option is not selected, then you must click on Print in the File menu.    This option will 
be restored if selected when the program restarts as long as Save Settings on Exit is selected.

Auto Save
See Automatically save my screen capture to a file

Auto Popup
Automatically displays the Print Screen Deluxe window when a screen capture is 
complete.

Auto Invert
Automatically performs the 'Special Effects'..'Invert' command on the image when it is captured.    Inverts 
or 'Reverses' the colors of the image, similar to the negative of the photograph.

Auto Gray Scale
Converts all the collors colors of the image into shades of gray when the image is captured.

Auto Start and Hide
Configures Print Screen Deluxe to start when Windows starts. 

Capture Options
See Capture a screen or capture a portion of the screen or window



Special Effects Menu

See Enhance the image with imaging effects

Notate

Add Comments
See Add Comments to my image 

Yellow Highlight
See How do I highlight a portion of my image in yellow - like a yellow highlighter marker?

Arrows
See How do I put arrows on my image to point out important things?

Command Line Options

/h 

Run Print Screen Deluxe as a hidden application.    You will not see a Window or an icon on the desktop 
when the program is running.    'AutoPrint' is the only option activated.    Therefore whenever you press the
screen capture hot key (default is <PrintScreen>) your screen or window will automatically print to your 
printer.

Ordering Print Screen Deluxe
Product Support



Print Screen Deluxe 5.2 Order Form and Registration
      
To print this form, click on the 'File' menu, then click on the 'Print Topic'    option.

Name          ______________________________________________

Company _____________________________________________

Address    ______________________________________________

City                ____________________________ State ______        Zip __________

Phone (______) ______-________ Fax (______) ______-________ e-mail ___________________

Important:    Is this your first product from American Systems?    (    )Yes    (    )No

_____      Number of Copies of Print Screen Deluxe

x $29.95    = $ ____________      (TEXAS residents add 8 1/4% sales tax.)

American Express (    ), Visa (    ) or MasterCard (    ) Number ________________________________ 
Exp. Date ___________

Signature: _________________________________________________

Make checks and money orders payable to American Systems.

P.O.s for more than $100.00 are welcome!                  Bulk pricing is available!

Call us toll free at    1-888-892-4310
Mail, or Fax your check or credit card details to :    

          American Systems
          P.O. Box 93747
          Southlake, TX 76092
          Care of Windows Utilities Division
                                                                                                        

or Order Online at    http://www.americansys.com and get the software right away!

Where did you get your evaluation copy from?

(    ) Internet
(    ) Vendor
(    ) BBS
(    ) CD-ROM
(    ) Friend
(    ) Other                      Name of source ___________________________________________
Note: Prices are effective January 15, 2005 and are subject to change.    Please enclose any comments you 
have.



How do I highlight a portion of my image in
yellow?

Click the Notate..Yellow Highlight command.    This will enable you to highlight a rectangle with yellow, 
much like you would with a yellow highlighter marker.    Once you select this command just draw a 
rectangle around the area you want to highlight.    The screen shot below is what you will see.



How do I put arrows on my image to point out
important things?

Arrows can be very useful when you want to point out something on an image, or you want to draw 
someones attention to a certain part of an image.    

You can choose any color of arrow you want and also choose a fat or thin arrow.

Click the Notate..Arrows command.    You'll see this window.

All you have to do is choose Thin Arrows or Fat Arrows, select the color of arrow you want, then click the 
arrow you desire.    Then you click on the image at the point where you want the arrow to appear.



Print the Current Date/Time, User's Name,
and/or Filename on the printout

When you click File..Print you'll see the following window.

You can set options for this printout like printing the current date and time, the user's name, the image file 
name, etc.    Then click <Print>

To change the default settings for the program so they will be set the way you like everytime you print 
something just do the following:

1. Click File..Preferences, then Program.    The following window will appear.



 

2. Notice the check boxes a the top.    Just check off the items you want printed each time you print an 
image.



How to I automatically make a printout lighter
or darker?

1. Click File..Preferences and the Print tab.

2. Check the 'Auto-lighten the printout' box.    And slide the bar from Darker to Lighter to suit your needs.




